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Overall Notes

WebHub v2.051+ uses a cross-platform sub-system named ZaphodsMap for configuration.  The concept of "SetupID"
from earlier versions of WebHub is implemented as "Context" in ZaphodsMap.  This idea lets a developer specify 
selected settings with different values depending on which machine the application runs on, e.g. Home versus Office.  
As you read through this document, you will occasionally see xml tags that have an attribute named "context".  These 
lines are reminders that you have the option of specifying that any leaf tag applies only to a given context.  We define 
a leaf tag as one which does not contain other tags.   

ZaphodsMap code is open-source.  Full  source to ZaphodsMap is included with WebHub and is available on 
sourceforge.  Further details about ZaphosdMap and code samples may be found at www.ZaphodsMap.com.

In this document, the current XSD for  each configuration file is highlighted in red.  Using the correct XSD filename 
is important if and only if you run ZMAdmin or use a tool such as Dreamweaver to validate the contents of your 
configuration files.   (In Dreamweaver, use the menu: File > Check File > Validate as XML.)

Whenever an xml value is meant to be a boolean, it must be entered as either "true" or "false" (lowercase).

The style sheet for all WebHub configuration files is the same:  
http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl.  Using the stylesheet is optional.  It helps when you 
want to view your configuration file using a web browser such as Internet Explorer or Firefox.

In this document, a few comments are included, and shown in (( double parens )).  Do not put comments into your 
own configuration files!   Anything shown in this color represents a planned feature.

HREF Tools Corp. has developed a tool named "ZMAdmin" which helps with browsing, opening and viewing your 
own ZaphodsMap configuration files.  ZMAdmin installs along with the WebHub Runtime System.  Use Start > 
Programs > HREF Tools > WebHub > ZMAdmin to launch it and explore your configuration.
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File: HREFTools\WebHub\cv004\ZMKeybox.xml

This ZMkeybox.xml file is created automatically when you install the WebHub Runtime System.  It will be located 
under the folder identified by the global environment variable named "ZaphodsMap".

The "keys" in this keybox file lead to the various configuration files used by WebHub.

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl"?>
<ZMKeybox xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://www.zaphodsmap.com/zmdesign/xsd/ZMKeybox200606.xsd">    
<Variables begin="{" end="}"> (( variables are always optional; the scope is the current xml file ))
    <Var name="DataPath" value="d:\AppsData\WebHub\"/>
    <Var name="AppConfigPath" value="D:\Apps\HREFTools\WebHub\config\"/>
  </Variables>
<KeyGroups>
    <KeyGroup name="WebHub">
      <Keys>
        <Key2File name="CentralInfo" filename="{DataPath}WHCentralInfo.xml"/>
        <Key2File name="License" filename="{DataPath}WHLicense.xml"/>
        <Key2File name="AppRestorer" filename="{DataPath}WHAppRestorer.xml"/>
        <Key2File name="DelphiWizard" filename="{AppConfigPath}WHDelphiWizard.xml"/>
        <Key2File name="NetworkInfo" filename="{DataPath}WHNetworkInfo.xml"/>
        <Key2File name="ServiceControl" filename="{DataPath}WHServiceControl.xml"/>
        <Key2File name="SystemMessages" filename="{DataPath}WHSystemMessages.xml"/>
        <Key2File name="EditorAutoFill" filename="{AppConfigPath}WHEditorAutoFill.txt"/>
        <Key2Folder name="CoverPageInfo" folder="{DataPath}CoverPageInfo\" />
        <Key2Folder name="Packages" folder="c:\Apps\HREFTools\WebHub\lib\pkgd07\"/>
     </Keys>
    </KeyGroup>
    <KeyGroup name="ZMAdmin">
      <Keys>
        <Key2File name="ZMAdminCustomPanel"

filename="{AppConfigPath}ZMAdminPanel-WebHub-cv004.xml"/>
     </Keys>
    </KeyGroup>
</KeyGroups>
</ZMKeybox>
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Key: CentralInfo
File: WHCentralInfo.xml

This file is created automatically when you first run the WebHub Runtime installer.  It defines your AppIDs.

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl"?>
<CentralInfo xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://static.webhub.com/xsd/cv004/WebHubCentralInfo201512.xsd">
  <Variables begin="{" end="}">
    <Var name="AppPath" value="d:\Applications\HREFTools\WebHub\"/>   (( vars scoped to the XML file ))
  </Variables>
  <WebHubAppGroups>
    <WebHubAppGroup name="HREF Tools Standard"> (( provided during installation ))
      <WebHubApps>
        <WebHubApp appID="appvers">
          <Nickname value="App version"/>
          <ConfigFolder value="{AppPath}config\whcp\"/>
          <ConfigFilename value="WHAppConfig_appvers.xml"/>
          <ErrorLogFolder value="c:\temp\wherrorlogs\"/>
          <ShareSessions value="true"/>
          <ShareByFile value="true"/>
        </WebHubApp>
      </WebHubApps>
    </WebHubAppGroup>
  <WebHubAppGroup name="EarthWave Vinyl Record Store" > (( the group name is arbitrary ))
   <WebHubApps>

<WebHubApp appID="recstore" > (( appID must be lowercase ))
<Active value="true" />
<Nickname value="Record Store" /> (( invent your own nickname ))
<ConfigFolder value="c:\path\" />
<ConfigFilename value="WHAppConfig_recstore.xml" />
<ErrorLogFolder value="path\path2\" />
<ShareSessions value="true" />
<ShareByFile value="true"/>
<SessionCookieName value="ewsession"/> (( can be "" ))
<SessionLocation value="CookieFixedDomain" /> (( default value="URL" ))
<Deployment>

<DefaultStartup mode="service" 
numToStartWithHub="3"
stopWithHub="true"  />

<ExecutableFolder value="path\" />
<ExecutableFilename value="recstore.exe" />
<ServiceName value="recstore" />
<Instances numToRunMinimum="2" numToRunMaximum="3" delaySecBetween="12" />

</Deployment>
</WebHubApp>
<WebHubApp appID="rmisc" >

<Nickname value="Stylus Department" />
<ConfigFolder value="c:\path\" />
<ConfigFilename value="WHAppConfig_rmisc.xml" />
<ErrorLogFolder value="path\path2\" />
<ShareSessions value="true" />
<ShareByFile value="true"/>
<SessionCookieName value="ewsession" />
<SessionLocation value="CookieFixedDomain" />
<Deployment>
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<DefaultStartup mode="service" 
numToStartWithHub="1" stopWithHub="true" />

<ExecutableFolder value="path\"  />
<ExecutableFilename value="rmisc.exe"  />
<ServiceName value="rmisc" />
<Instances numToRunMinimum="1" numToRunMaximum="2" delaySecBetween="10" />

</Deployment>
</WebHubApp>

<WebHubApp appID="remoterecstore" >
<Nickname value="Testing RecStore" />
<ConfigFolder value="c:\path\" />
<ConfigFilename value="WHAppConfig_recstore"  />
<ErrorLogFolder value="c:\path\path2\" />
<ShareSessions value="true" />
<ShareByFile value="true"/>
<Deployment>

<DefaultStartup mode="application" numToStartWithHub="0" />
<ExecutableFolder value="c:\path\" />
<ExecutableFilename value="recstore.exe" />

            <DebugMode value="true" />
<Instances numToRunMinimum="1" numToRunMaximum="1" delaySecBetween="0" />

</Deployment>
</WebHubApp>

   </WebHubApps>
  </WebHubAppGroup>
  </WebHubAppGroups>
  <HubProcess>
    <DefaultAppID value="appvers"/>
    <GuardianIntervalSeconds value="90" />
    <LoggingLevel value="warning,error,exception"/> (( v3.238+ ))
    <RandomNextInstance value="false" />
  </HubProcess>
  <Sessions>
    <SessionDebug value="False"/>
    <SessionDebugLogFile value=""/>
    <SessionDigits value="10"/>
    <SessionFileMask value="*.var"/>
    <SessionFolder value="c:\temp\whSessions\"/>
    <SessionLifeMinutes value="240"/>
    <SessionPrefix value="0"/>
    <SessionSweepIntervalMS value="120000"/>
  </Sessions>
  <RunnerConfiguration>
 <RunnerTimeoutSec value="30"/>

<RunnerEchoEnabled value="True" />
  </RunnerConfiguration>
  <MaitreD>
    <RoundRobin appID="adv" serverProfileIDList="defprofile|secure|defprofile|demo"/>
  </MaitreD>
</CentralInfo>

File: WHLicense.xml
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The WHLicense.xml file contains the name of the license owner, the expiration date (if any), and the serial number.

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl"?>
<WebHubLicense xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://www.zaphodsmap.com/zmdesign/xsd/WebHubLicense200605.xsd">
  <WebHubCentral>
    <Licensee value="WebHub Lite License until 31-Dec-2016"/>
    <SerialNo value="196.210.13.118.88.106.239.81.229.223.13.135"/>
  </WebHubCentral>
</WebHubLicense> 
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File: WHAppConfig_AppID.xml

The AppID definitions within the CentralInfo file lead to this type of file, an application configuration file.  There are 
two samples included with the WebHub Runtime System, and many examples available on demos.href.com.  The 
example below is entirely fictitious.  It includes all possible tags.  Normal applications only need to configure a small 
subset of these tags.

For new WebHub applications, let the New AppID Wizard help you.  This wizard is available in Delphi, under the 
menu: Project > WebHub > New AppID.  It creates the XML file plus starter .whteko files.

<WebHubAppConfiguration xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://static.webhub.com/xsd/cv004/WebHubAppConfiguration201601.xsd">

<Startup>
<MenuEnabled value="false" />
<MenuEnabled value="true" context="home" />
<SplashEnabled value="true" />
<StartMinimized value="true" />
<TrayIconEnabled value="true" />
<Modules>

<StandardModules>
<GUIOptional>

<Module name="dreamweaver" status="enabled" />
<Module name="dreamweaver" status="enabled-gui" context="home"/>
<Module name="dwsecurity" status="enabled-gui" />
<Module name="email" status="enabled-gui" />
<Module name="googlesitemap" status="disabled"/> // v3.246+
<Module name="shareint" status="disabled" />

</GUIOptional>
<GUI>

<Module name="appin" status="disabled" />
<Module name="appout" status="enabled-gui" context="home"/>
<Module name="decode" status="disabled"/>
<Module name="whteko" status="enabled-gui" />

</GUI>
</StandardModules>
<CustomModules>

<GUIOptional>
<Module name="mydatamodule" status="enabled" />

</GUIOptional>
<GUI>

<Module name="mypanel" status="enabled-gui" />
</GUI>

</CustomModules>
</Modules>

</Startup>
<Application>

<AppProperties>
<DynURLConfig>

<ServerProfileIDStandard value="iis" /> (( special case: (~APPID~) allowed ))
<ServerProfileIDSecure value="ssl(~APPID~)" />
<ForceCase value="lower" />
<UseAppID value="true" />
<UseAppProcessID value="false" />
<HideAppProcessID value="false" />

</DynURLConfig>
<ProjectSyntax value="0214" />
<ProjectLingvo value="eng" />
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</AppProperties>
<AppSettings>

<AppSetting name="custom1" value="unknown1" />
<AppSetting name="custom2" value="unknown2" />

</AppSettings>
<ErrorAlertFlags>

<ErrorAlertFlag name="Summary" value="true" />
<ErrorAlertFlag name="Comment" value="true" />
<ErrorAlertFlag name="LogToFile" value="true" />
<ErrorAlertFlag name="Send" value="true" />
<ErrorAlertFlag name="ShowPageCreationExceptions" value="false" />

</ErrorAlertFlags>
<ErrorSituations>

<ErrorSituation name="RejectSession" logToFile="true" />
</ErrorSituations>
<EventMacros>

<EventMacro id="getfield" groupCode="a" />
</EventMacros>
<MediaSources>

<MediaSource  id="1" value="(~chSimpleDNSAdvertisement~)" />
<MediaSource  id="2" value="(~chHREFAdvertisement~)" />
<MediaSource  id="3" value="(~chHREFRSUAd~)" />

</MediaSources>
<PageGeneration>

<AutoPageFooter dropletName="None" />
<AutoPageHeader dropletName="None" />
<YesNoString value="Yes,No"/>
<Syntax0100>

<MacroPageBegin value="" />
<MacroChunkBegin value="" />
<MacroSectionBegin value="" />
<MacroEndMarker value="" />
<MacroEndBuffer value="" />

</Syntax0100>
<Sequencing> (( optional section ))
   <Up caption="up" activeImage="BtnUp.png" dimImage="GreyUp.png" />
   <Prior caption="prev" 

activeImage="(~mcSeqDir~)BtnPrev.png"  
dimImage="(~mcSeqDir~)GreyPrev.png" />

   <Next caption="next" activeImage="BtnNext.png" dimImage="GreyNext.png" />
   <Stop caption="stop" activeImage="BtnStop.png" dimImage="GreyStop.png" />
</Sequencing>

</PageGeneration>
<RemoteDesignDefaultInterface>

<AllowedSessionIDRange value="1200-1210"/>
<RemoteAccessPages>

<Page function="refresh" pageID="remoterefresh" />
<Page function="design" pageID="remotedesign" />
<Page function="preview" pageID="remotepreview" />

</RemoteAccessPages >
<AllowedIPRange value="192.168.3.*;10.10.3.3"/>
<TestingServerURLPrefixMappedTo value=""/>

</RemoteDesignDefaultInterface>
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<Security>
<AdminSessionNumber value="12345678" />
<CookieDomainDefault value="dsp.href.com" /> (( SessionLocation = CookieFixedDomain ))

<ReadOnlySessionNumber value="12999" />
</Security>
<Situations>

<AdminSideDoor pageID="pgAdminSideDoor" />
<ChangedIP pageID="pgChangedIP" /> (( was BadIPPage ))
<ChangedUserAgent pageID="pgChangedUserAgent" /> (( was BadBrowserPage ))
<Exception pageID="pgError" /> (( new ))
<FrontDoor pageID="pgFrontDoor" /> (( was FrontDoor ))
<Home pageID="pgHome" /> (( was HomePage ))
<Invalid pageID="pgInvalid" /> (( was InvalidPage ))
<InvalidDo pageID="pgInvalidDo" /> (( was NoDoPage ))

</Situations>
<Static>

<AppRoot value="/dspdesign/" />
<ExportBackupGenerations value="3" />
<ExportFolder value="path\" /> (( was ExportDir ))
<ExportURLPrefix value="/foo/" /> (( was ExportURL ))

</Static>
<StreamCatcherInterface>

<WebRobotIniFilespec
 value="c:\...\SCWebSiteConfig_wwwMySiteID.cfg" />

<WebRobotIniSection value="wwwMySiteID.WebHubURLFiltering" />
</StreamCatcherInterface>
<TekoAutoFolders> (( planned ))

<AutoFolder value="path\" />
<AutoFolder value="path2\" />

</TekoAutoFolders>
    <TekoFiles>

  <File id="about" filename="about.whteko" />
  <File id="ads" filename="dspads.whteko" />
  <File id="dsp" filename="dsp.whteko" />
  <File id="form" filename="form.whteko" />
  <File id="homepage" filename="home.whteko" />
  <File id="dreamweaver" filename="remotedw.whteko" />
  <File id="welcome" filename="welcome.whteko" />
  <File id="mirrors" filename="mirrors.whteko" />
  <File id="feedback" filename="feedback.whteko" />

    </TekoFiles>
</Application>
<ComponentConfig>

<whCycle componentName="WebCycle"> (( 'whCycle' equals the Family property of TwhActions ))
<ItemList>
      <Item id="01" value="Delphi XE4 Book"/>
      <Item id="02" value="Delphi Component Design"/>
</ItemList>

</whCycle>
<whdbForm componentName="dbform1">

<FormatEditFields>
<Item id="a" value="fieldname1"/>

</FormatEditFields>
</whdbForm>
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<whdbScan componentName="scanEmployee">
<Delimiters macroPrefix="mcEmployeeDelimiters" />
<ButtonSpecs macroPrefix="mcEmployeeButtonSpecs" />
<Captions macroPrefix="mcEmployeeCaptions" />

</whdbScan>
<whdbSource componentName="wdsEmployee">

<KeyFields value="EmplNo" />
<Arrangements>

<Item id="ByName" value="idxLastname" />
</Arrangements>
<Prompts macroPrefix="mcPrompts" />
<DisplaySets>

<Item id="SimpleView" value="Lastname;Firstname;Telephone" />
</DisplaySets>
<IndexOrders>

<Item id="ByName" value="idxLastname" />
</IndexOrders>

</whdbSource>
<whErrors componentName="webErrors1">

<ItemList>
<Item errorNum="1" errorMessage="message 1" />

</ItemList>
</whErrors>
<whListGrid componentName="listGrid1">

<ItemList>
<Item id="01" filename="datafile.txt" />

</ItemList>
</whListGrid>
<whListScan componentName="listScan1">

<Delimiters macroPrefix="mcDelims" />
<ButtonSpecs macroPrefix="mcButtonSpecs" />
<Captions macroPrefix="mcCaptions" />

</whListScan>
<whLogin componentName="webLogin">

<ItemList>
<User id="JDoe" fullName="John Doe" passPhrase="initials" password="jd" 

active="yes" expires="" access="" other="" />
</ItemList>

</whLogin>
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<whMailForm componentName="WebMailForm">
<Item name="formLetter">

<Host value="smtp.swiftdsl.com.au"/>
<Port value="25"/>
<SMTPUsername value="" />
<SMTPPassword value="" />
<From value="info@href.com"/>
<Name value="Someone on the Web"/>
<To value="EMailTo^"/>
<Cc value="customerservice@href.com"/>
<Bcc value="techsupport@href.com"/>
<ReplyTo value="customerservice@href.com" />
<Subject value="Subject^"/>
<ExcludeStringVars value="telephone"/>
<Include value="stringvars;boolvars"/>
<Template value="letters\form-ltr.txt" />
<Template value="letters\form-ltr.txt" context="office"/>
<TxtVars value="txtComment" />
<LogToFile value="false"/>
<LogFilespec value=""/ >
<LogStringVars value="" />
<NextPage value="" />

</Item>
</whMailForm>
<whScanKeysGrid componentName="scankeysgrid1">   (( see Rubicon text search engine ))

<ButtonSpecs macroPrefix="mcSpecs" />
<Captions macroPrefix="mcSpecs" />

</whScanKeysGrid>
<whStringGrid componentName="stringgrid1" /> (( unused ))
<whWebAction componentName="webmailCaptcha">

        <Item id="LengthFull" value="18"/>
      <Item id="LengthKey" value="7"/>
</whWebAction>
<whWebAction componentName="mywebaction1"> (( for any webactions of family “whWebAction” ))

<Item id="mysetting1" value="myvalue1" /> (( use for individual items ))
<ItemList listName=""> (( use to treat entire list as a set ))

<Item id="a" value="aaa" />
<Item id="b" value="bbb" />

</ItemList>
</whWebAction>
<Component name="aaa" > (( planned for use by any Delphi component ))

<Item id="taaa" value="valueaaa" />
<Item id="DatabaseAlias" value="DSP" context="home" />
<Item id="DatabaseAlias" value="_DSP" context="office" />
<ItemList listName="listaaaa">

<Item id="a" value="aaa" />
<Item id="b" value="bbb" />

</ItemList>
</Component>

 </ComponentConfig>
</WebHubAppConfiguration>
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Correspondence between Standard Module names, Delphi unit names and Delphi classes
based on WebHubAppConfiguration200811.xsd
implemented by whcfg_App.pas, uAutoDataModules.pas and uAutoPanels.pas

Module Name in
Help/Docs

GUI Delphi unit name Delphi class name

dreamweaver Dreamweaver optional whdw_RemotePages.pas (non-gui) TDataModuleDreamWeaver

whpanel_RemotePages.pas (gui) TfmWhDreamweaver

dwsecurity Dreamweaver 
Security

optional whsample_DWSecurity.pas TdmDWSecurity

email EMail optional whMail.pas (non-gui) TDataModuleWhMail

whpanel_Mail.pas (gui) TfmWebMail

shareint Shared Refresh optional whShared.pas (non-gui) TDataModuleShared

whpanel_Shared (gui) TfmCommon

appin In/Out > Input required whAppIn.pas TfmAppIn

appout In/Out > Output required whAppOut.pas TfmAppOut

decode WHTeko > Decode required whpanel_Decode.pas TfmWhHtmlDecoder

googlesitemap Google Sitemap required whsample_GoogleSitemap.pas TfmwhGoogleSitemap

whteko WHTeko > Files required whHtml.pas TfmAppHTML

Macro definitions associated with the <whdbScan_tag>

The following could be defined in one of the .whteko files associated with the application:

<whmacros>
mcEmployeeButtonSpecsFirst=<a href="(~where~)ScanEmployee.First">FIRST</a>
mcEmployeeButtonSpecsPrior=<a href="(~where~)ScanEmployee.Prior">PRIOR</a>
mcEmployeeButtonSpecsNext=<a href="(~where~)ScanEmployee.Next">NEXT</a>
mcEmployeeButtonSpecsLast=<a href="(~where~)ScanEmployee.Last">LAST</a>
mcEmployeeCaptionsFirst=FIRST
mcEmployeeCaptionsPrior=PRIOR
mcEmployeeCaptionsNext=NEXT
mcEmployeeCaptionsLast=LAST
mcPromptsArrangement=<b>Arrangement</b>:
mcPromptsIndexOrder=<b>Index Order</b>:
mcPromptsDisplaySet=<b>Display Set</b>:
mcPromptsFieldSet=<b>Field Set</b>:
</whmacros>
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Key: ServiceControl
File: WHServiceControl.xml

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl"?>
<ServiceControl xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://static.webhub.com/xsd/cv004/WebHubServiceControl200608.xsd">

<Services>
<Service id="firebird-sql-server" serviceName="fb" sequence="1" delaySecBefore="3" 

startWithHub="true" stopWithHub="true" context="HOME" />
<Service id="ftp-server" serviceName="servudaemon" sequence="2" delaySecBefore="8" 

startWithHub="true" stopWithHub="false" />
</Services>

</ServiceControl>

Key: CoverPageInfo
File: \CoverPageInfo\AppID\WHCoverPageInfo-AppID.xml

Cover pages appear when a WebHub application is "suspended" or intentionally closed.  The contents of a cover page 
are specified through System Message configuration, with a few key details loaded from the following CoverPageInfo
file.

A CoverPageInfo file can be generated using WebHubView.exe's menu: Tools > Cover App.  It can also be generated 
from the AServer.exe interface, by toggling the Suspend feature.  A function is provided in whutil_ZaphodsMap.pas.

<CoverPageInfo>
<CoveredOnAt value="23-Jan-2015 01:02:03" /><!--- this is GMT -->
<ExpectedMinutes value="15" />
<Reason value="database structure upgrade" />
<AdminAccessAllowed value="true" />

</CoverPageInfo>

WebHub v3.15x Runner query strings

?r:vers, to show the version number or '-' if disallowed
?r:version, to confirm that the runner has a valid runner id from WHNetworkInfo.xml
?r:ipc, to show 'x' for cross-platform or '-' if disallowed
?r:echo, including display of configuration details when running on localhost or on the admin domain
?r:refresh, to reload all configuration data
?r:coverwhapp- + AppID, to say look for downtime file for AppID
?r:uncoverwhapp- + AppID, to say look for (lack of) downtime file for AppID
?h:vers, to show the version number of the Hub if it is running, or '-' if disallowed
?h:ipc, to show the ipc of the Hub (which must match the runner), or '-' if disallowed
?h:nct, to show number of connected instances, total, or '-' if disallowed
?h:hca- + AppID, to show the number of connected instances for AppID, or '-' if disallowed
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Key: SystemMessages
File: WHSystemMessages.xml

This file is installed with the WebHub Runtime System, along with a starter set of .whmsg files.

<SystemMessages xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://static.webhub.com/xsd/cv004/WebHubSystemMessages201307.xsd">
  <Variables begin="{" end="}">
    <Var name="SysMsgRoot" value="c:\Program Files\HREFTools\WebHub\config\sysmsg\"/>
  </Variables>
  <Situations>

<AllSituationsDefault appID="adv" value="{SysMsgRoot}advgeneral.whmsg" />
<AppCoverPage  appID="" value="/AppCoverPage.html" />
<AppCoverPage   appID="appvers" value="{SysMsgRoot}appcoverpage-appvers.whmsg.html" />
<AppCoverPage   appID="hubvers" value="{SysMsgRoot}appcoverpage-hubvers.whmsg.html" />
<AppIDBusy  appID="" value="{SysMsgRoot}appidbusy.whmsg" />
<AppNotDefined      appID=""      value="{SysMsgRoot}appnotdefined.whmsg" />  
<AppNotRunning     appID=""      value="{SysMsgRoot}appnotrunning.whmsg" />  
<AppShuttingdown  appID=""      value="http://webhub.com/appshuttingdown.html" /> 
<HubNotFound    appID=""      value="{SysMsgRoot}hubnotfound.whmsg" />
<RequestTimeout appID=""      value="{SysMsgRoot}requesttimeout.whmsg" />

  </Situations>
  <MsgContentTypes> (( new in WebHub v3.192 ))

<MsgContentType appID="" value="text/html" />
<MsgContentType appID="bw" value="text/xml" />
<MsgContentType appID="demos"value="text/json" />

  </MsgContentTypes>
  <MsgContentTypeOverrides> (( new in WebHub v3.192 ))

<Override id="a1" pageIDMatch="pgxml" whmsgSuffix="xml" contentType="application/xml" />
<Override id="a2" pageIDMatch="xml" whmsgSuffix="xml" contentType="application/xml" />
<Override id="aa" pageIDMatch="ajax" whmsgSuffix="ajax" contentType="text/html"/>
<Override id="bb" pageIDMatch="json" whmsgSuffix="json" contentType="application/json"/>

  </MsgContentTypeOverrides>
  <Text>

<AppCoverPage value="temporary admin mode" />
<AppIDBusy value="application busy" />
<AppNotDefined value="invalid AppID" />
<AppNotRunning value="app not running" />
<AppShuttingDown value="app in process of shutting down" />
<HubNotFound value="hub.exe not running or not available" />
<Minutes value="minutes" />
<RequestTimeout value="request timeout" />

  </Text>
</SystemMessages>
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Key: NetworkInfo
File: WHNetworkInfo.xml

This configuration file needs to be set up carefully for each deployment machine.  It identifies the WebHub runner(s) and associates them with 
an http server (e.g. IIS, Apache or Sambar)  and a mode of operation (e.g. with StreamCatcher).

<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="http://www.ZaphodsMap.com/zmdesign/css/ZaphodsMap.xsl"?>
<WebHubNetworkInfo xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="http://static.webhub.com/xsd/cv004/WebHubNetworkInfo201511.xsd">
   <HttpServers>

<HttpServer id="apache" nameStartsWith="Apache" 
sendHttpVersion="false" sendHttpColon="false" httpForceCase="upper" />  (( was HttpColon and UseHttpHeader))

<HttpServer id="iis" nameStartsWith="Microsoft IIS 6" 
sendHttpVersion="true" sendHttpColon="true" httpForceCase="upper" />

<HttpServer id="iis" nameStartsWith="SAMBAR" 
sendHttpVersion="true" sendHttpColon="true" httpForceCase="upper" />

  </HttpServers>
  <LocalMachine>

<ConnectionLayer> (( new in WebHub v3.192 ))
<SharedLogFolder value="d:\temp\whTestLogs\" />
<WorkingFolder value="e:\temp\ipc\" />

</ConnectionLayer>
<Runners>

<Runner id="a" filespec="c:\inetpub\scripts\runisa.dll" >
<Active value="true" />
<Interface value="isapi" />
<DelayMS value="50" />
<UploadFolder value="c:\temp\" />
<ErrorLogFolder value="c:\temp\" />
<UploadMaxFileSizeKB value="100" />
<AdminAccess scheme="http" authority="admin.href.com:443" />

</Runner>
<Runner id="b" filespec="c:\htdocs\cgi-bin\runbin.exe" >

<Interface value="cgi-bin" />
<DelayMS value="0" />
<UploadFolder value="c:\temp\" />
<ErrorLogFolder value="c:\temp\"  />
<AdminAccess scheme="http" authority="localhost:80" />
<ForcesThisAppID value="adv" />

</Runner>
</Runners>
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  <ServerProfiles>
    <ServerProfile id="defprofile">

<HttpServerID value="iis" />
<Scheme value="http" />
<Authority value="www.href.com:80" />
<AllowDynamicAuthority value="true" />
<RunnerPath value="scripts/" />
<RunnerID="a" />
<URLUseShortFormat value="false" />
<URLDelimiter value=":" />
<URLForceCase value="upper" />
<URLUseLingvo value="false" />
<URLUseScheme value="false" />

    </ServerProfile>
    <ServerProfile id="secure">

<HttpServer value="iis" />
<Scheme value="https" />
<Authority value="www.href.com:443" />
<AllowDynamicAuthority value="false" />     // generally false on https
<RunnerPath value="scripts/" />
<RunnerID value="a" />  
<URLUseShortFormat value="True" />
<URLDelimiter value="/" />
<URLUseLingvo value="true" />
<URLUseScheme value="false" />

    </ServerProfile>
 </ServerProfiles>
  </LocalMachine>
  <OtherMachines>
  <ServerProfiles>

    <ServerProfile id="securehref" >
<HttpServerID value="iis" />
<Scheme value="http" />
<Authority value="secure.href.com:80"  />
<URLRunnerSpec value="/scripts/runisa.dll" />
<URLUseShortFormat value="true"  />
<URLDelimiter value=":" />
<URLUseLingvo value="false" />

    </ServerProfile>
  </ServerProfiles>
  </OtherMachines>
</WebHubNetworkInfo>
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